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Abstract

ASHUTOSH DEEPAK PHATAK. Development of A Phasor Measurement Unit for Low

Voltage Power Networks. (Under the direction of DR. MACIEJ NORAS)

With the increase in technological advances of the smart grid, distribution systems have
undergone a great change the same as transmission systems: new technology, different
types of load, demand response supporting facilities, large quantities of distributed power
interconnection to the distribution network. Meanwhile, the capacity of the distribution
network, that is, the number of component an size of investment is considerable, even more
than transmission grid. Power measurement plays an important role in distribution
networks, including income measurement, voltage amplitude measurement for capacitor
switching, distribution feeder current measurements, system device protection
measurement. As the next point of setup in smart grid, PMU is necessary for components
control, fault detection and control, energy management in the distribution network and
increasing reliability and power quality. With technological revolution in Solar and Wind
farms, energy can be generated at the destination of consumptions. Use of energy storage
devices like batteries has also gone up. To use the existing system effectively, the
Bidirectional flow of power takes place. This bi-directional flow can cause trip off, causing
frequency or voltage problems. The electrical behavior load is changing.

The design of distribution is radial, so more monitoring/measurements points are required.

The traditional monitoring at a lower revenue per circuit mile like that of transmission



system, the number of measuring instruments goes up, causing high monitoring costs and
larger manpower. At such times, micro PMU can be installed. These micro PMU will
monitor and measure data in real time system and communicate with PDCs using GPS
signals. The developed PMU offers a wide variety of monitoring options like using web

enable browsers and hand-held android or iOS devices.
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Introduction

Generally, a network consist of generators, loads and transmission lines and other different
components that are needed to control the power flow and maintain a balance between
demand & supply supervisory control and data acquisition[1]. With increase in technology
in 20™" century, the system became a complex electrical network. Analysis of the behavior
of tis complicated system required a great deal of effort and resources. Mathematical
methods such as symmetrical components along with iterative computational methods
were invented and employed to assist engineers in designing and managing the electric

grid.

These relays used symmetrical components of voltage and current to convert the 6-fault
transmission line to a single equation using symmetrical components. With time, the
microcomputers became sufficiently capable of handling advance algorithms. However,
symmetrical component distance relay method was much efficient for measuring voltages
and current. [2] This method also found its way into various power system analysis like

load flow, short circuit, stability, power flow and state estimations etc.

An alternating current following through an inductor (purely inductive, no resistance) will
have the voltage across the inductor will have a phase difference of 90degree with the
current. Accordingly, there will be phase shifts in RL, RC, RLC circuits. Since, AC
guantities have both magnitude and a phase angle between them it is best to represent them
using phasor diagram. It also helps us to find the relationship between two or more AC
quantities and find the resultants. A phasor is a complex number which represents a
sinusoidal function whose amplitude, angular velocity and initial phase angle are time

variant. [3] An AC waveform can be mathematically represented by the equation as follows



x(t) = X, cos(wt + @)
Where, X,,, = magnitude of sine wave
wt = angular velocity
@ = initial phase angle
The phasor notation of this waveform is representedas x = X,,, < @

In an electrical system represented below, there are two buses with voltage V1/ 61 and
voltage V2/ §2. The bus is at maximum voltage of V1 with initial phase angle of 61, while
bus 2 is at voltage V2 with initial voltage as 62. The phasor representation of two waveform

is shown below.
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Figure 1: phasor representation of waveforms [2]

The phasor representation of electrical quantities has been well adopted in power
engineering. It is commonly utilized in computational algorithms, and its use has been

extended to all aspects of power grid control, monitoring and protection. However, to



perform all the computations needed in the power network, knowledge of the real values
of voltages and currents in the grid are required. Measurements are taken at various
strategic locations of the network with a help of current (CT) and voltage (VT)
transformers. All that data is then aggregated and processed to give an accurate picture of
the grid state. Due to far distances between the measurement points it became important
that times at which measurements were taken were somehow determined and reported as
well. This may be somewhat difficult when using local time references, as they may be
offset with respect to each other. The need for time-coordinated phasor measurements of
currents and voltages at the electric grid gave birth to devises known as phasor
measurement units (PMUs), where the data are collected and reported using a common

global positioning system (GPS) coordinated time base.

Literature and working.

After a catastrophic failure of Eastern power grid in north America in 1965, a great deal of
research was being conducted for determining the state of power system in real time. This
was achieved by use of real time measurements obtained from GPS enabled measurement
devices. The main aim was to collect and analyze the voltage magnitude and phase angle
at each nodes or buses.[2] This process is called State Estimation. In 1970s, it was not
possible to achieve synchronous measurements. Hence, symmetrical components were
used to obtain measurement of the power system. The state obtained consist of positive

sequence component of voltage at each bus.

In 1980s large number of GPS satellite were deployed. With the use of these satellites, GPS
enabled measurement devices were powerful tools. These GPS enabled devices would be

able to provide instantaneous picture of the state of the power system, and in fact would



have many outstanding features which would make these measurements become effective
immediately even if complete observability of the network could not be achieved with the
new measuring devices. Using GPS time signals as input to the sampling clock in

measurement system, once can have Real-Time picture of steady state of power system.[1]

By using all the available tools, the Power System Research Laboratory of Virginia Tech.
developed first Phasor Measurement Unit (PMU). The PMU has Voltage measuring
potential transformers (PTs) and Current Measurement transformers (CTs) connected. The
fig below shows the connection of PMU along with CT and PT in electrical grid.

Power
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TL <«
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GPS TR PMU %\nﬁ;—

I

Communications

Figure 2 : PMU connection along with CT and PT [5]

This PMU used GPS transmission to synchronize all the sampling clocks across the grid,
so that the calculated sequence voltages and phasors will have common reference. This
numbers are called as Synchrophasor. Synchrophasor are time synchronized numbers

which represents both magnitude and phase angle of a sine wave in an electrical grid. [4]

The system comprises a master system and several local units. The system is arranged as

three layers. The bottom layer consists of PMUs with additional protection functionality.



The next layer consists of several Local Backup Protection Centers (LPCs), each of which
interfaces directly with many PMUs. The top layer, System Backup Protection Center
(SPC), acts as the coordinator for the LPCs. [5] The SPCs are connected via fiber-optic
communication links, these devices can process intelligent algorithms based on data

collected locally. The image below shows the basic operation of PMU in an electric grid.

Integrated Application Design
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Figure 3: Synchronized Phasor measurement system [5]

Application and Uses
Now-a-days there are several smart grid applications that have been designed for

improvement, protection and control of power system in a real time environment. [6] The

most known used approach is use of wide-area monitoring, protection and control.



For control

Before the introduction of phasor measurements, the power system was controlled using
local measurement devices such as CTs and PTs and mathematical model of the system.
However, this approach was highly inaccurate and produced unacceptable system

response.

By using high speed PMU, the system can be accurately modelled and controlled.
Accurately obtained positive sequence voltage and phasors are used to simulate the system
algorithm and provide feedback to the system loop using controllers. Such a system can be

controlled and monitored in a real time.

For Protection

In existing system, the protection was based on use of relays and circuit breakers using CTs
and PTs. The system mostly relied on backup schemes where the fault was cleared
depending upon time it reached the next node. However, the drawback of this approach
was false tripping of relays and CBs. and dependability. With simple system, the tradeoff

between false trips and clearing of the fault wad tolerable. [7]

With increase in system complexity and use of power electronics, over sensitive remote
zones are created. A trip may occur due weather conditions such as High temperatures,
wind, rain, fog or fire on these over sensitive zones. This trip is not because of equipment
failure or faults occurring on the system. Such trips are called false trips. When such a false
trip occurs on a complex system that is already on stress, a cascading failure occurs. This
fault multiplied to a large disturbance in the system. If this fault was not cleared by the

protection levels, the fault may cascade and damage the whole system. Using well-placed



PMUs, this false trip can be identified at each node and checked for known conditions that
occur during a fault. If it’s determined that it was a false trip, subsequently the trip is cleared

in the next cycle.

For Event Detection

With the increasing loading of the power system, along with the massive interarea transfers
enabled by the deregulation of the 1980s and 1990s, there is a clear need to have reliable
information about both the local system and external systems. Incidentally four of the six
major North American blackouts were due in part to a lack of situational awareness.
[8]Although there is a clear need for sharing of information, there is limited real-time
sharing of supervisory control and data acquisition (SCADA) or state estimator information
in the United States. However, as phasor measurement units (PMUs) have been deployed
throughout the North American power grid, there have been significant efforts to ensure
that the PMU data are shared between all interested parties. Because PMU data are more
widely available in near real-time than other power system measurement data, a fault can
be identified of its nature and its impact on the system and cleared without propagation to
the system failure. Assuming known nature of steady state system, the event detection

algorithms are used to classify different events.

Need of micro PMU

With the start of smart grid, distribution systems have undergone a great change the same
as transmission systems: new technology, different types of load, demand response
supporting facilities, large quantities of distributed power interconnection to the

distribution network. Meanwhile, the capacity of distribution network, that is, the number
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of component an size of investment is considerable, even more than transmission grid. [9]
However, little attention is paid to how to improve the distribution network in the past, and
in recent years, the study of distribution automation is gradually getting more attention.
Power measurement plays an important role in distribution networks, including income
measurement, voltage amplitude measurement for capacitor switching, distribution feeder
current measurements, system device protection measurement. [10] These measurements
are part of the SCADA in each voltage level of power grid. Measurements area
synchronous in the past, in the other word, measurement happened in different time and
without a unified clock trigger signal. As we all know, using advanced measurement
techniques to achieve control and economic operation in the transmission grid and
distribution network is one goal of smart grid. To take full advantage of the measured
values, synchronous measuring of current and voltage is even more necessary especially in
field of control, which prompt the all- phase measurement. The PMU is used for accurate
measurement of synchronous phasor of electric signals at separated points across the power

grid and are widely installed at the transmission level.

As the next point of setup in smart grid, PMU is necessary for components control, fault
detection and control, energy management in distribution network. Customer expectations
regarding reliability and power quality are getting higher every day. People expect
continuous uninterrupted power all the time. Loss of power can cost millions in the

economic development.

There are more and growing amounts of Distributed Energy Resources in distribution
systems. With technological revolution in Solar and Wind farms, energy can be generated

at destination of consumptions. Use of energy storage devices like batteries has also gone



up. To use the existing system effectively, Bidirectional flow of power takes place. Energy
is generated in surplus during daylight using solar panels and concentrated solar powers.
This surplus energy is supplied to meet the peak demands during day time using the
existing transmission system. At night, the same system is used to supply back power from
generation to the distribution sectors. Due to this Bi-directional flow of power takes place
in same system. This bi-directional flow can cause trip off, causing frequency or voltage

problems.

Changing behavior of load

The design of distribution is radial, so more monitoring/measurements points are required.
The traditional monitoring at lower revenue per circuit mile like that of transmission cannot
be used to monitor the complex distribution system. With increase in the radial system, the
number of measuring instruments goes up, causing high monitoring costs and larger man
power. At such times, micro PMU can be installed. These micro PMU will monitor and
measure data in real time system and communicate with PDCs using GPS signals. The
Technology for PMU is already implemented for transmission system, but was needed to
be cheaper to be deployed in distribution system. In this project, we can see that using same
technology, the cost of PMU has been reduced from $22,000 to $7,000 saving $15,000.
The installation cost may be up to $200. The saved cost can be used to deploy another two
micro PMUs and achieve better response, dependability and reliability. The developed
micro PMU is much smaller in Size and more easily deployable (i.e. like hot stick mounted
devices). The size is reduced to %th of the PMU used in transmission system. The
developed PMU also offers wide variety of monitoring options like using web enable

browsers and hand-held android or iOS devices.



Chapter 3: components of PMU

The Architecture of micro PMU is built with keeping National Instruments Grid
Automation System as benchmark for the PMU. The choice of NI Grid Automation System
was based on cRIO advantages along with interchangeable plugin modules available for

different applications. Below are all the components described along with their advantages.

3.1 cRIO 9068
CompactRIO is a real time embedded industrial controller made by National Instruments

for industrial control systems. The CompactRI10 is a combination of a real-time controller,

reconfigurable 10 modules, FPGA module and Ethernet expansion chassis. [11]

Increased technical performance

Figure 4: Boost technical performance with intel chips

CompactRIO controllers offer the performance to execute advanced control algorithms
with deterministic response times and low latency. Take advantage of the latest

advancements in processing and heterogeneous computing elements including ARM-based

10



Xilinx Zynqg SoCs as well as quad-core Intel Atom processors and Xilinx Kintex-7 FPGAs.
[8]

Simple design and addon modules

Figure 5: cRIO with different modules for variety of application

Eliminate the need for separate subsystems by connecting to sensors, displays, cameras,
motors, databases, and the enterprise directly from CompactRIO controllers. Create a
powerful system that you can customize and reconfigure through software—even after

deployment. [8]
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Innovative platform for different applications and needs.

| - - < [

Figure 6: Plug and play modules for wide applications

With highly integrated software, a community of users and IP, extensive 1/O, and a range
of embedded controllers across a variety of form factors, a single platform can help you to

meet the unique needs of any embedded application. [8]

Advantages of FPGAs

Figure 7: Graphical environment for better user interaction

From high-speed signal and image processing to custom timing and ultra-precise control,
FPGAs deliver the performance and reliability to meet even the most demanding technical
requirements. Use the LabVIEW graphical environment to program the onboard FPGA and

12



unlock the incredible power of these devices without any knowledge of hardware

description languages or placing and routing tools. [8]
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3.2 measuring modules (voltage and current)

Voltage measurement module 9242

Ni Module 9242 is a 250 Vrms L-N, 400 Vrms L-L, 50 kS/s/ch, 24-Bit, 3-Channel C Series
Voltage measuring Input Module. This module performs single ended analog signals. The
wide measurement range makes it ideal for high-voltage measurement applications such as
phasor measurements, power metering, power quality monitoring, standard potential
transformers, and motor test. [9] We can also perform transient and harmonic analysis with
high-speed simultaneous sampling. The N1-9242 offers three channels, so we can connect
single-phase or three-phase measurement configurations such as WYE and delta. We can

incorporate the N1-9242 into systems to meet standards of IEEE ¢37.118

Acquiring signals from NI 9242

To acquire voltage signal and test the working of NI 9242 module, following steps were

implemented.

Steps:

1. Open “getting started with NI 9242” from LabVIEW examples as shown in fig 8.

2. Right-click RT CompactRI10 under the LabVIEW project and select NEW, select Target

and Devices.

3. Select Discover the existing chassis and select CompactR1O with the IP-address of the

chassis.

4. Expand the project under the chassis and select the FPGA main.VI.

14



5. Compile the FPGA main.VI.
6. Attach connecting wires to measure the voltage from source.

7. Check for broken Run arrow, if not the VI can be operated to test sample signals.

B3} Nio242 Getting Started.lvproj * - Project Explorer - ] x
File Edit View Project Operate Tools Window Help

ltems Files

= [ﬁ, Project: NI 9242 Getting Started.lvproj
=- ¥ My Computer
| L. Build Specifications
=- [&# RT CompactRIO Target (192.168.1.111)
= @@ Chassis (cRIO-9068)
=8 FPGA Target (RIO0, cRIO-9068)
& @ Chassis I/O
- @ Modil
- BB 40 MHz Onboard Clock
- 4l Data
-+ i) IP Builder
-~ i@ Mod1 (Slot 1, NI 9242)
-~ [mgl NI 9242 Getting Started (FPGA).vi
- .é Build Specifications
- [mdl NI 9242 Getting Started (Host).vi
- 4 Build Specifications

:

Figure 8: Getting started with NI 9242 project
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3 NI 9242 Getting Started (Host).vi Front Panel on NI 9242 Getting Started.lvproj/RT CompactRIO Target
File Edit Window Help

> [&] @[ ][ 15pt Application Font | |

Tools

View Project Operate

& |[ch- +| Search 4 [[?]

e

Uverview: Demonstrates how to acquire data from the NI 9242 . 2
Requirements: LabVIEW Full Development System, LV FPGA, and NI RIO
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Figure 9: Front panel of NI 9242 project
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Edt View Project Operste Tooks Window Help [
3@ @[1n][F] (5] [va]5* 2 120t Application Font |~ |[$= |[Ta | (8~ [Fal] o Searc 1 ][?] o]
Extract the four channels from the
rtatenred dt. cehb.ateand‘mnemedm.cumpw @ 1)
lthe time base from the Data Rate setting,
RIO Device
2k s Sf - L - = error ou
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Steps:

1. Open a reference to the FPGA VI and FPGA target.

2. Set the rate at which the NI 9242 acquires data.

3. Run the FPGA VI on the FPGA target. Additionally, set the number of samples to read per loop
iteration.

|4. Read the measured data from the DMA FIFO.

5. Display the measured Data.

6. Check the status of the FIFO and FPGA.

7. Read the error indicators on the FPGA target, and close the reference to the FPGA VI,

[FT3222 Getting Stantedvproy AT CompactRI Targel <

Figure 10: Block diagram of NI 9242 Host VI
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Figure 11: waveforms measured by NI 9242 Host VI
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Current Measurement Module NI 9238

NI module 9238 is £500 mV, 50 kS/s/ch, 24-Bit, Simultaneous Input, 4-Channel C Series
a current measuring Module. This module (N1-9238) performs differential analog input.
The measurement range is compatible with many low-voltage sensors such as current
shunts and current transducers in high-current applications. When used with higher-voltage
C Series Voltage Input Modules, the NI-9238 can measure power and energy consumption
for applications such as appliance test, industrial machine monitoring, power quality

analysis, phasor measurements, and harmonic analysis. [10]
Acquiring signals from NI 9238

To acquire voltage signal and test the working of NI 9242 module, following steps were

implemented.
Steps:
1. Open “getting started with NI 9238 from LabVIEW examples shown in fig 12.

2. Right-click RT CompactRI10 under the LabVIEW project and select NEW, select Target

and Devices.

3. Select Discover the existing chassis and select CompactR10 with the IP-address of the

chassis.
4. Expand the project under the chassis and select the FPGA main.VI.
5. Compile the FPGA main.VI.

6. Attach connecting wires to measure the current from source.

18



7. Check for broken Run arrow, if not the V1 can be operated to test sample signals.

2} NI 9238 Getting Started.lvproj - Project Explorer

m Edit View Project Operate Tocols Window Help
ltems Files

[Lg. Project: NI 9238 Getting Started.lvproj
LJ g My Computer
j t Build Specifications
= lz‘ RT CompactRIO Target (192.168.1.111)
=- - Chassis (cRIO-9068)
=8 FPGA Target (RIOO, cRIO-9068)
oy ‘Chassis I/O N
£33 Q Meod1

o 40 MHz Onboard Clock
~|I|-> Data
- gg) IP Builder
[i Mod1 (Slot 1, NI 9238)

NI 9238 Getting Started (FPGA).vi

& .é Build Specifications
- |, NI 9238 Getting Started (Host).vi
°é Build Specifications

Figure 12: Getting started with NI 9238 labVIEW project
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Figure 14: Block diagram of NI 9238 Host VI
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B

File Edit View Project Operate Tools

Belon

Window Help

A
Overview: Demonstrates how to acquire data from the NI 9238
Requirements: LabVIEW Full Development System, LV FPGA, and NI RIO
Instructions:
1. Run the VI,
Waveform Graph h
R P (!
e Lt 0.8+ Channel 0 m
RIO Device
I’ J Channel 1 -
% rio://192.168.1.111/RI00 |»
Channel 2 m
Channel 3 m
Timing Parameters T
v
Samples Per Channel to Read 3 0- Data FIFQ Full Elements Remaining
A 5
o 1000 & 9 0
< -02- FPGA error out Host error out
’)Data — 0 status  code status  code
7 2.000 kS/s (NI 9238) Bt ﬂ !— J
0 J ! 0
0.6
External Shunt Resistance (Ohms) SoHree SouEE
J,J: 1.001 08 0 | 0 | i " "
0 0.1 02 03 04 0.5
Time (s) | Y v
STOP
v
NI 9238 Getting Started.lvproj/RT CompactRIO Target| < >

Figure 15: waveforms measured by NI 9238
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Chapter 4: Experimental setup

Once we have our CompactRIO system up and running, we should be able to open the "PQ
Starter Kit" and run it. If we get a broken arrow related to the bit file error, Double-click

and find the . lvbitx" file that is in the starter kit folder.
Using the Starter Kit with Different CompactRIO Hardware [12]

This example was developed for deployment with the starter kit hardware. To run this
project on different hardware, you need to configure a project to run your specific hardware
connected to your computer. The following steps guide you through the process of creating

a new project for your hardware.

From the example LabVIEW Project Explorer, choose File » Save As...

Edit View Project Operate Tools Window Help
New VI Ctri+N B bl | FR~ 2 o ||| W
New... :
Open... Ctri+- O
Close Ctri+W
Close All
Save Ctri+S
Sawve All Ctri+Shift+S

Sawve All (this Project)
Sawve for Previocus Version...

New Project
Open Project...
Save Project
Close Project

Recent Projects >

Recent Files >

Exit Ctri+=Q

Figure 16: Saving PQ starter kit project

22



1. In the Save dialogue that appears, choose the Duplicate.lvproj file and
contents radial button and ensure that the Include all dependencies radial button

is selected. Then press Continue...

( "
ﬂ Save "PQ Starter Kit.lvpro

Original file
| C:\Users\bburger. AMER\Desktop\Power Monitoring with cRIO Starter Kit\PQ Starter Kit.lvproj

Copy - create an unopened copy of the .lvproj file on disk

® ? ﬁ Rename - rename the .Ivproj file on disk

@ P Duplicate .lvproj file and contents
- ‘ @ Include all dependencies

Original will be in memory. Copy will not be opened.

(") Select contents to copy

[Continue...][ Cancel H Help ]

Figure 17: Duplicating all dependencies from original project to New project

2.  Select a folder to store your new project and its associated files. Choose an
appropriate name for the project file as well. All other project contents maintain

the same name as used in the original example.

3. Close the original example project.
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4.

Open the newly saved project and right-click the top-level Project: <Name>,
where <Name> is the title of your project. Then choose New » Targets and
Devices...

43 Project Explorer - NEW PQ Starter Kit.lvproj SN

File Edit View Project Operate Tools Window Help

S HE | . o all5 S W= R ol

Items [ Files

New Target Folder

Explore... Targets and Devices...

Show in Files View

New...

Save

Save As...

Save All (this Project)
Mass Compile...

View
Find Items with No Callers
Find Missing Items

Arrange by
Expand All
Collapse All

Rename...

Properties

Figure 18: adding target cRIO from connected devices

From the Add Targets and Devices dialogue that appears, choose the Existing
target or device radial button and ensure that Discover an existing target(s) or
devices(s) radial button is also selected if your device is on the same subnet as

your development computer.
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43 Add Targets and Devices on NEW PQ Starter Kitvproj

Targets and Devices
‘@ Existing target or device
© Discover an existing target(s) or device(s).

() Specify a target or device by IP address,

(") New target or device

Targets and Devices

#1{2) Real-Time CompactRIO

&3 Real-Time Desktop

@lfi‘) Real-Time Industrial Controller
&) WSN Gateway

< | m

Reduce discovery timeout

| Refresh |[ ok || Cancel || Help |

Figure 19: Dropdown list for Target and devices

7. Expand the Real-Time CompactRIO folder under Targets and Devices and

choose your CompactRIO option from the list.

8. Press OK.

9.  The Select Programming Mode dialogue box appears. It is important to choose
the correct programming mode for your example. The Power Monitoring Starter Kit
needs the chassis to be configured for FPGA interface mode rather than scan mode.

You have the choice to discover installed modules. Though either way works, adding
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the modules later is easier. You should now have a project (as depicted below) with
two targets, the original “DEMO-9024" target and the new one you just added. The

idea now is to drag all the components from the original target to your new target.

43 Project Explorer - NEW PQ Starter KitIvproj JE=TEEE X

File Edit View Project Operate Tools Window Help

hSHG| s D X9k EE

Items | Files |

=kl Project: NEW PQ Starter Kit.lvproj

o B My Computer

i % Dependencies

. % Build Specifications

E;} m DEMO-9024 (10.0.59.179)

= [ RT CompactRIO Target (0.0.0.0)
c+ @8 Chassis (cRIO-9112)
& FPGA Target 2 (RIO0, cRIO-9112)
.. 57 Dependencies
.. ‘@ Build Specifications

|| %

Figure 20: adding FPGA from Demo project to New project

10. Drag the VI under the old RT CompactRIO controller and place it under the new
CompactRI10O controller you just added to the project in the same relative location. Note
that the VIs need to be placed under the proper targets. “PQ Host Program” should live

under the RT target, and “[FPGA] Main” should be pulled under the FPGA target on
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the chassis. Don't forget the “DATAU32” DMA channel from the FPGA target. The
image below shows the “PQ Host Program” after it has been moved from the original

target to the new one.

{3 project Hiﬁz arter Kitlvproj * :
File Edit View Project Operate Tools Window Help

S HE| £ B 0|k R

Items | Files

=l Project: NEW PQ Starter Kit.lvproj
= B My Computer
i = Dependencies
.. ‘@ Build Specifications
&+ [ih DEMO-9024 (10.0.59.179)
@ @ Sub Vis and Controls
i @@ Chassis (cRIO-9111)
- @57 Dependencies
-, Build Specifications
- i RT CompactRIO Target (0.0.0.0)
i PQ Host Program.vi
= @@ Chassis (cRIO-9112)
. - §8 FPGA Target 2 (RIOQ, cRIO-9112)
& %' Dependencies
‘®. Build Specifications

Figure 21: Adding Sub VIs and Control from Demo project

11. For the folders, create a virtual folder and convert it to “auto-populating” to pull

in all the sub VIs. Select the appropriate folder from the project folder on disk.
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File Edit View Project Operate Tools

Window Help

[ SHY | ¥xXHh X

a5k |-

Items | Files

=3 [B Project: NEW PQ Starter Kit.lvproj

= W My Computer

i % Dependencies

.. ‘@ Build Specifications
&+ [ith DEMO-9024 (10.0.59.179)

- [@ Sub VIs and Controls
i @@ Chassis (cRIO-9111)
& = Dependencies

E Build Specifications

PQ Hos Simulation Subsystem

. @l Chassis  Add
e e
: %51 Depeng EQZZed_ ¢t Control
‘% Build S ISCONNEC )
Utilities by
Variable
Deploy I/O Server
Deploy All Class
Arrange by Targets and Devices...
Expand All Unit Test
Collepse Al —
Remove from Project
Rename... F2
Help...
Properties

Figure 22: Adding new virtual folder
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I3 Project Explorer - NEW PQ Starter Kit.vproj *
File Edit View Project Operate Tools Window Help

MOSHB| XD XY Q||| @&

Items | Files

= [ Project: NEW PQ Starter Kit.lvproj
= B My Computer
i %' Dependencies
- @ Build Specifications
&+ il DEMO-9024 (10.0.59.179)
@ @ Sub Vis and Controls
i @@ Chassis (cRIO-9111)
' % Dependencies
i+ . Build Specifications
- it RT CompactRIO Target (0.0.0.0)
.. |l PQ Hos
& . Chassis|  Add »
=] FPG4
@ C

.. ¥ 4¢  Find Project Items...

@ B

New >

Convert to Library

i+ % Depend  Unit Tests
- . Build Sp

Analyze Vs...

Remove from Project
Rename...

Figure 23: converting the virtual folder to auto-populating

12. Channel address names are important. The easiest way to use similar names is by

following these steps:

a.  Add “C Series Modules” by right-clicking on the FPGA target

b.  Delete the associated folder that is automatically created (usually named “Mod#”)

c.  Change the name of the module to match the name in the PQ Starter Kit project

(for example, I or V for current or voltage)
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d.

e.

File Edit View Project Operate Tools

Window Help

Right-click on the newly named module and select New » FPGA 1/0O

Channels are now addressed based on the module name

[MESH@| xh I XY

|| w5 b | B~ o]

Items | Files

& B My Computer

=- k) Project: NEW PQ Starter Kit.lvproj

- % Dependencies
'é Build Specifications

= [, DEMO-9024 (10.0.50.179)

G+ [@ Sub Vls and Controls
- (@@l Chassis (cRIO-9111)
i+ % Dependencies

& .& Build Specifications

=+ [ RT CompactRIO Target (0.0.0.0)

@ @ Sub Vs and Controls
- ml PQ Host Program.vi
= @@ Chassis (cRIO-9112)

& [

S N T

’ 4 Start IP Generator... Mot olier
i I
B Execute Vion > fc;ntro
ibrary
# %' Depend :
.é Build S RIO Device Setup... Class
Add > C Series Modules...
Start FPGA Wizard.. EoRnee
FPGAL/O
Arrange by > FPGA Base Clock
Expand All FIFO
Collapse All Memory
Remove from Project Component:teve I
Rename... F2
Help...
Properties

Figure 24: adding cRIO modules
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13. After you have created folders, moved VIs, and discovered modules, you can
remove the old system from the project by right-clicking it and selecting Remove from

Project.

Window Help

NSHE| XD XYk @& |

Items ' Files

= (Bl Project: NEW PQ Starter Kit.lvproj
&+ § My Computer
= Dependencies
i L% Build Specifications

i [ RT Ce

Add 4

Connect
Disconnect

Utilities 4

Deploy
Deploy All

Arrange by >
Expand All
Collapse All

Remove from Project

Rename... F2

Help...
Properties

Figure 25: Deleting Demo project

14. Open the [FPGA] Main program and note that the run arrow is broken. This is
normal. You need to make a few adjustments before the program can execute on your

new target.
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a. Synchronize the NI 9225 and NI 9227 modules by right-clicking one of them,

going to Properties, and checking “Export Onboard Clock.”

b.  On the other module, go to Properties and use the “Master Time base Source”
pull-down to select the module for which you just exported the onboard clock. The

modules can now synchronize within the chassis.

C. Check for broken wires. If the channel address names are not correct, there may
be a broken wire on the 1/0 nodes. Channel order is important, so note the VO, 10, V1,

I1... pattern (see image below).

d.  Once all the broken wires are gone, save and close the VI.
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13 C Series Module Properties

Module Configuration

Name
1 \

=8 Module Configuration

Module Type
‘ ‘ 4-Ch 5 Arms 24-Bit Simultaneous Analog Input

=]

Calibration Mode
Calibrated =

Master Timebase Source

! <Onboard Clock> E]‘\ Export Onboard Clock

Data Rate

[ 0K ][ Cancel H Help

Figure 26: synchronizing all on board clocks

15. Open the “PQ Host Program” and press the Run button on the front panel. Before
the example runs, you are prompted to compile the FPGA VI. Once you have
completed this compilation, the example runs automatically. Compilation is system-

dependent but should take around 20 minutes.
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4.1 Configuring Remote Front panels on a Real-time system.

To host a Remote Front Panel on a real-time (RT) target so that we can view the front panel

of the application running in a web browser following steps are implemented.

Once we have checked to make sure you have an active Remote Panel License, we can

proceed with the following steps:

1. In LabVIEW RT 8.6 and later, you must explicitly install the Web Server for
LabVIEW RT to the RT target to host a Remote Front Panel on it. In LabVIEW RT
2014, this component is called the Remote Panel Server for LabVIEW RT. Refer
to the Remote Systems Help in Measurement & Automation Explorer (MAX) for

information on how to do this. [13]
2. Open a project and add an RT target to the project:

a. In the Project Explorer, right-click LabVIEW.lvproj file and select New

»Targets & Devices....

b. From the Add Targets and Devices window, select or create your RT
target.

rﬁ FProject Explurer g@w

File Edit “ew Project Operate Tools W

% & W e | 9

Items | Files

=1 E; Prniact: RemateFrontPanelR karai |

i f Mew 3 Target Folder

- Explore... Targets and Devices. ..
i Shows in Files Yiev Zkrl+E

= (@ Mew, .,
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3. Enable the web server on the RT target:

Right-click the target in the project and select Properties.

Select the Web Server category from the left pane.

Make sure that the Enable Web Server checkbox is checked. Also, verify
that Visible VIs and Browser Access have the correct permissions setup
(* can be entered to allow access to all Vs or IP addresses).

Click OK.

Right-click the target again, and select Deploy. This will deploy the
settings to the target.

These settings will not take effect until the next time the target boots. We
can reboot the target now or wait until later.

Note: In LabVIEW 2010, the default port is Port 8000. In versions prior to

LabVIEW 2010, the default port is Port 80.

{3 Real-Time PXI Properties

Category [[

General

Conditional Disable Symbols

W] Server General

Web Server

Uset fccess [+]|Enable Web Server
Host Environment
Miscellaneous
Web Services: Security Basic Sekttings
Scan Engine

Server labels (porks)
LabWIEW (50 -

4. Generate the HTML file for the Remote Front Panel:
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Open the VI if it is not already open.

. Open the Web Publishing Tool by going to Tools»Web Publishing Tool....

In the VI Name drop-down box, select your V1. You will notice that

the Snapshot and Monitor Viewing Modes become grayed out. This is because
those modes are not supported on RT targets.

Proceed through the Web Publishing Tool wizard and customize as desired. On
the final screen, it is recommended to change the Filename of the HTML file to

something short and meaningful.

Click Save to Disk. This will save the HTML to the destination directory and add

it to your project under your target.

{3 Web Publishing Tool

Select Y1 and Yiewing Options

VI name
=Seleck a vl > v
4 <Select avl... =

RemokeFrontPanelkB . [vproj/DisCo-PrI-31 86 FemoteFrontPanelkB . vi

Browse, ..
Front panel remotely

Build your RT application:

Right-click Build Specifications under the target and select New » Real-Time
Application.

. Select the Source Files category from the left pane.

Select your VI and click the arrow to add it to Startup VIs.

. Select your HTML file and click the arrow to add it to Always Included.
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Source Files

Project Files Startup YIs

= |l RemoteFrontPanelkE . vi
C3
L

Always Included
] RemoteFrontPanelk B, html

(=]
[«=]

e. Select the Destinations category from the left pane.

f. Click the blue plus sign (+) to add a new destination.

g. Change the Destination label to something more meaningful, such as www.

h. Change the Destination path to c:\ni-rt\system\www on a PharLap or VxWorks

Target or /var/local/natinst/labview/www on a Linux RT target. This corresponds

to the web server directory on the target.
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Destnatons

Destinations -~
skarktup.rkexe
Suppork Direckory [RTENTPN]

Destination label

Deskination pakth
cHni-rEhy sy skem e

De=skination bvpe
(&) Directory
[C1Preserve disk hierarct

(I LLE

[1add Files to mewvs project li

Library mame

Source File Setfings

Project Files | - Inclusion Type
=Hizf) Always Included
I;Q, RemoteFrontPanelkB, vi
& RemoteFrontPanelkB. html: Diestination

! ;
= Dependencies
KAl e

6. Select the Source File Settings category from the left pane.
a. Select your HTML from the Project Files list and change
the Destination drop-down box to the destination you created (i.e. www).
b. Customize the rest of the build specification as desired. Click Build.
7. When the build is finished, right-click the application and select Run as startup.
This will set the application as a startup application, deploy the application to the
target, and then prompt you to reboot the target. When you are prompted to reboot

the target, click Yes.
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rﬁ Project Explurer g@w

File Edit “ew Project Operate Tools W

eS| % X 9 ¢

Items | Files

=3 ng, Project: FemoteFrontPanelkB. lwproj
= B My Computer

H BE :

{ = Dependencies

+% Build Specifications

= l_ﬁ DisCo-P¥I-G186 (10.0,35.170)

- |mel, RemateFrontPanelkE, vi

- |@| RemoteFrontPanelkE. hkml

? Dependencies
=8 +% Build Specifications
My Real-Time &pplication
Deploy
Build
Explore

Run as startup

8. When the target comes up after the reboot, your application should be running,
and the Remote Front Panel should be accessible. To verify this, open a web

browser and navigate tohttp://XxX.XxXx.XXX.XxxX:yyyy/<file name>.html,

where XXX.XXX.XXX.XxX is the IP address of the target, yyyy is the port assigned to

host the Web Server in step 3, and<file name> is the name of the HTML file that

was generated from the Web Publishing Tool.

http://192.168.1.111:8000/PQ_starterkit.html
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4.2 LabVIEW project and panel diagrams

B rQ starter Kit.lvproj * - Project Explorer = |
File Edit View Project Operate Tools Window Help

ltems Files

= &l Project: PQ Starter Kit.lvproj
& EF
| Windows_Ul.vi
. '@ Build Specifications
= [} NI-cRIO-9068-01bb5523 (192.168.1.111)
@+ [@ Sub Vis and Controls
# [ 3 All_Three_Voltage_Phases.lvlib
i @@ Chassis (cRIO-9068)
.- el PQ Host Program.vi
’ € PQ Starter Kit.lvproj_NI-cRIO-9068-01bb5523_PQ Host Program.html
~ (3 Rremote_Server.ivlib
i+ [ 3 Untitled Library 1.Ivlib
@[3 Untitled Library 2.lvlib
@[3 Untitled Library 3.vlib
& [ 3 Untitled Library 4.Ivlib
i3 Untitled Library 5.vib
& [ 3 Volt_Phase_1_Var.lvlib
@[3 Volt_Phase_2_Var.vlib
@[3 Volt_Phase_3_Var.vlib
- g Waveform_Current_Phase_1.lvlib
- @ Build Specifications

Figure 27:Power Quality LabVIEW project
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B
File Edt View Project Operate Tooks Window Help

[ 11 || 15pt Application Font |+ | v || vhav

Waveform Display |V Data  Power Monitoring

Phase Display
2 &
Trigger Level
Hysteresis

Phase Adjust

Voltage

B

RMS Trend

g1

Voltage_Phase_1

Juaund)

Voltage Phese 2

-1
J

Phase1
[phase2

[Jphase3

STOP
V/AI0 Phase. 1
0
V/AI0_Phase 2
0
V/AID Phase 3
0

Voltage Phase 3 All_Three_Phaces

SETUP Parameters

RT Data Buffer Used %]

0
Frequency Nominal V.
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Samples per Read

5000
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1000085
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Channel Name ~ Scale [mV/EU] EU  dBRef [EU]
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| 1 1000.00 | 1
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|.z 100000 |1 V &

Figure 28: Front Panel of PQ_Host VI

y
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4.2 Block diagrams

B 2 Host Pragram vi Block Diagrarm 8 %
File Edit View Project Operate Tools Window Help

RMS Voltage
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Phase 1 ActPlot
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V/AI) Phase 2
V/AID Phase 3
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Figure 29: Block diagram of Host VI partl
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Figure 30: Block diagram of Host VI part2
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Chapter 5: Results
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Figure 32: Phase angle and Frequency of waveforms
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Figure 33: Power characteristics
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Chapter 6: Conclusion
The developed micro PMU can be used to monitor voltages, current and power usage in a

system. The micro PMU is a prototype that works for nominal voltage of 120 volts and 15
amps current. The analog input channels that are designed for potential transformer and
current transformer inputs use high-speed, high-resolution converters that sample at up to

1,000 samples per cycle with 24 bits of resolution.

Although the micro PMU works for nominal voltage and current, it needs to be tested for
different scenarios and test case before it is market deployable. Some of the standard test

conducted on PMU analysis are as follows,

* Power and Energy Calculations (IEC 61000-4-30)

* Unbalance (IEC 61000-4-30)

« Flicker (IEC 61000-4-15)

* Event detection and aggregation (IEC 61000-4-30)

» Harmonic Analysis (IEC 61000-4-7)

* Phasor Measurements (C37.118.1a-2014 PMU)
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